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caractéristiques de votre 
nouveau lecteur MP3
Attrayant. Intelligent. Fiable. Et beaucoup de plaisir. Votre nouveau lecteur 
MP3 vous offre tout cela et encore plus. Cet appareil à la fi ne pointe de la 
technologie vous offre un son riche, des images éclatantes de couleur et des 
jeux pleins d’action. Vous adorerez votre nouveau lecteur MP3 pendant vos 
exercices, pour télécharger votre musique préférée, visionner vos vidéos, jouer 
à vos jeux favoris ou même pour écouter la radio FM.
Un seul essai, et vous vous demanderez comment vous avez pu vivre sans lui.

NOUS AVONS AJOUTÉ LE “MULTI” DANS 
MULTIMÉDIA
Nous l’appelons un lecteur MP3 mais c’est 
encore beaucoup plus. Il vous permet de 
visionner des photos, des textes, des vidéos 
et aussi d’écouter la radio FM et de jouer à 
des jeux.

NAVIGATION TACTILE !
Naviguez dans les menus en touchant 
simplement l’écran tactile.

CONÇU AVEC ÉCRAN ACL COULEUR
Les images de couleurs éclatantes 
s’affi chent sur son grand écran ACL.

LE LECTEUR MP3 M’OFFRE LA LIBERTÉ DE 
CHOISIR MES SÉLECTIONS FAVORITES !
Il vous permet de créer des listes d’écoute 
de votre musique favorite.

DURÉE DE LECTURE PROLONGÉE ET DE 
TÉLÉCHARGEMENTS PLUS COURTS !
Un bloc-piles pleine charge peut vous offrir 
jusqu’à 30 heures de musique ou 4 heures 
de vidéo. 
La durée de téléchargement est plus courte.
Grâce à sa capacité USB 2.0, le lecteur 
est beaucoup plus rapide que les modèles 
utilisant la capacité USB 1.1.

UNE MERVEILLE ACOUSTIQUE
Votre nouveau lecteur MP3 possède l’engin 
DNSeTM (Engin de son naturel numérique), 
une technologie sonore unique à Samsung 
créée pour produire une son plus riche, 
plus profond. Il vous offre une expérience 
d’écoute inimaginable.



consignes de sécurité
Signifi cation des icônes et des symboles contenus 
dans ce manuel :

AVERTISSEMENT
Indique des risques de dommages corporels ou de mort.

ATTENTION

Indique un risque potentiel de dommages corporels ou 
matériels.

ATTENTION

Veuillez respecter les consignes de sécurité suivantes 
afi n de réduire les risques d’incendie, d’explosion, 
d’électrocution ou de dommages corporels lorsque vous 
utilisez votre lecteur MP3 :

REMARQUE

Indique des conseils ou des pages de référence qui 
pourraient vous aider à utiliser le lecteur.

Ne PAS tenter.

Ne PAS démonter.

Ne PAS toucher.

Suivre explicitement les directives.

Débrancher la fi che d’alimentation de la prise murale.

Appeler le centre de services pour de l’aide.

Ces symboles d’avertissement sont là pour vous protéger contre les 
dommages corporels, vous et les autres. Veuillez les respecter à la lettre. 
Après avoir lu cette section, veuillez la conserver pour consultation ultérieure.



consignes de sécurité
Ce manuel décrit le mode d’emploi approprié de votre nouveau 
lecteur MP3. Veuillez le lire attentivement afi n d’éviter de vous blesser 
ou d’endommager le lecteur. Veuillez particulièrement respecter les 
avertissements sérieux qui suivent :

PROTÉGEZ-VOUS
Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil 
vous-même.

Ne mouillez pas l’appareil et ne le laissez pas tomber dans l’eau. 
Si le produit devient mouillé, ne l’allumez pas. Cela peut entraîner des 
risques d’électrocution. Contactez plutôt le centre de service à la clientèle 
Samsung le plus proche.

Évitez d’utiliser le produit pendant les orages. Cela peut provoquer une 
risque d’électrocution ou une défaillance de l’appareil.

N’utilisez pas l’écouteur lorsque vous conduisez une bicyclette, une 
automobile ou une motocyclette.
bicyclette, une automobile ou une motocyclette. Dans le cas contraire, vous 
risqueriez de provoquer un accident grave. En outre, son utilisation est interdite par 
la loi dans certaines régions.
Utiliser des écouteurs en marchant ou en joggant sur la route et en particulier sur 
un passage pour piétons peut entraîner un accident sérieux.

Pour votre sécurité, veillez à ce que le cordon des écouteurs ne 
s’emmêle pas dans vos bras ou dans d’autres objets environnants 
pendant vos exercices ou vos marches.

Ne rangez pas l’appareil dans un endroit humide, poussiéreux ou 
couvert de suie, sous peine de provoquer un incendie ou une décharge 
électrique.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTÉGEZ-VOUS
Le port des écouteurs ou d’un casque d’écoute pendant une période 
prolongée peut causer des troubles de l’ouïe sérieux.
Une exposition prolongée à un son plus élevé que 85 dB peut avoir un effet négatif 
sur votre ouïe. Plus le son est élevé, plus le problème de l’ouïe peut être sérieux 
(une conversation ordinaire s’élève entre 50 et 60 dB et le bruit de la route à environ 
80 dB). Nous vous recommandons fortement de régler le volume sur un niveau 
moyen (le niveau moyen se situe habituellement aux 2/3 du niveau maximum).
Si vous entendez un bourdonnement, baissez le volume ou cessez 
l’utilisation des écouteurs ou du casque.

PROTÉGEZ VOTRE LECTEUR MP3
Ne rangez pas l’appareil dans un lieu où la température excède 35° C 
(95° F) (comme dans un sauna ou une voiture en stationnement par 
exemple).
Évitez tout impact brutal sur l’appareil (ex. : en cas de chute).
Ne posez pas d’objets lourds sur le lecteur.
Empêchez que des particules externes ou de la poussière ne pénètrent 
dans l’appareil.
Ne placez pas le produit près d’un objet à propriétés magnétiques.
Veillez à toujours enregistrer vos données les plus importantes. 
Samsung dénie toute responsabilité pour les pertes de données.
Utilisez toujours les accessoires fournis ou agréés par Samsung.
Évitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil 
à l’aide de produits chimiques (ex. : benzène ou diluant) sous peine de 
provoquer un incendie, une décharge électrique ou une détérioration de 
la surface.
Suivez attentivement ces instructions sous peine de provoquer des 
dommages corporels ou d’endommager l’appareil.
Si vous souhaitez imprimer ce manuel, nous vous recommandons de 
l’imprimer en couleur et de cocher l’option d’imprimante “Ajuster à la 
page” pour une meilleure lecture.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION
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principes fondamentaux
ARTICLES COMPRIS
Votre nouveau lecteur MP3 vous parvient accompagné des accessoires 
suivants. Si certains de ces articles sont manquants, contactez le centre de 
service à la clientèle de Samsung.

Lecteur Écouteurs

Câble USB CD d’installation

L’aspect des accessoires est susceptible d’être amélioré et modifi é, sans 
notifi cation préalable. 
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VOTRE LECTEUR MP3

Affi chage à l’écran

Commutateur Power 
(Alimentation) et Hold (Maintien)

Faites coulisser vers le bas du 
lecteur et maintenez pour allumer 
ou éteindre le lecteur.
Faites coulisser vers le haut du 
lecteur pour verrouiller les fonctions 
des touches.

Trou de réinitialisation
Si une défaillance se produit, 
appuyez sur le bouton de 
réinitialisation à l’aide d’un objet 
pointu pour réinitialiser le système.

Microphone
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VOTRE LECTEUR MP3 (Suite)
Ces touches sont de type « tactile ».

Touche de retour en arrière
Tapez sur la touche pour vous déplacer 

vers l’écran précédent. Appuyez 
longuement sur la touche pendant un 

court moment pour vous 
déplacer vers le menu principal.

Touche d’augmentation du volume
Tapez sur la touche pour augmenter le 
volume sonore ou pour vous déplacer 

sur un élément/menu supérieur.

Touche Lecture/Pause et Sélectionner 
Tapez sur la touche pour sélectionner 

lecture/pause et la fonction, ou pour vous 
déplacer vers l’écran suivant.

Flèche de gauche du navigateur de fi chiers
Tapez sur la touche pour sélectionner 
la piste ou le menu précédent ou pour 
lire la piste en cours à partir du début 

Appuyez. longuement sur la touche 
pendant un court moment pour balayer 

rapidement les pistes..

Touche de diminution du volume
Tapez sur la touche pour diminuer le 

volume sonore ou pour vous déplacer 
sur un élément/menu inférieur.

Flèches de droite du navigateur de fi chier
Tapez sur la touche pour vous déplacer sur la piste 

ou  sur le menu suivant. Appuyez longuement sur la
touche pendant un court moment pour balayer 

rapidement les pistes.

Touche Menu
Tapez pour affi cher le menu.
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VOTRE LECTEUR MP3 (Suite)

Écouteurs
Ils sont marqués d’un “L” pour 

l’écouteur de gauche et d’un 
“R” pour l’écouteur de droite. Ils 

servent aussi d’antenne FM pour 
le lecteur MP3.

Si vous débranchez les écouteurs 
durant la lecture de musique, le 

lecteur passera en mode Pause..

Prise de branchement des 
écouteurs

Port USB

Trou de la cordelette
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Music
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ÉCRANS D’AFFICHAGE
Musique

1 Témoin du menu parent

2 Témoin de verrouillage

3 État de la pile

4 Piste présentement en lecture / 
témoin du nombre de pistes

5 Témoin de vitesse de lecture

6 L’heure actuelle

7 Durée totale de la lecture

8
Témoin de lecture/pause et 
recherche

9 Témoin du mode musique

10 Témoin du mode lecture

11 Témoin du mode DNSe

12 État de la lecture de musique

13 Titre de la musique

14 Barre d’état de la lecture

15 Durée actuelle de la lecture

Les représentations à l’écran fi gurent à titre indicatif uniquement. 
L’écran réel de votre appareil peut être différent.
Toutes les informations autres que l’écran de lecture disparaîtront en quelques instants.
Pour affi cher à nouveau, tapez toute touche.

REMARQUE
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ÉCRANS D’AFFICHAGE (Suite)
Vidéo

1 Témoin de verrouillage

2 État de la pile

3 L’heure actuelle

4 Durée totale de la lecture

5
Témoin de lecture/pause et 
recherche

6 Témoin du mode vidéo

7 Nom du fi chier

8 Barre d’état de la lecture

9 Durée actuelle de la lecture
Picture

1 Témoin de verrouillage

2 État de la pile

3 Témoin Fichier actuel / 
Nombre total de fi chiers

4 L’heure actuelle

5
État de la lecture de 
musique

6 Témoin du mode Photo

7 Témoin du menu parent

8 Nom du fi chier

Video Track 1

5

6

7

8

9

1

2

3

4

[Écran de prévisualisation]
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ÉCRANS D’AFFICHAGE (Suite)
Radio FM

1 L’heure actuelle

2 État de la pile

3 Témoin de verrouillage

4 Témoin du mode Radio

5
Témoin manuel/
préprogrammé

6
Témoin de la fréquence 
actuelle (MHz)

7
Témoin de localisation de la 
fréquence

1

Manual

3

4

6

7

2

5
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UTILISATION DES TOUCHES
Tapez délicatement sur la touche tactile du bout du doigt.

Pour éviter d’endommager l’écran tactile, évitez d’utiliser un objet autre que vos 
doigts pour le manipuler.
Veillez à garder les mains propres lorsque vous souhaitez utiliser le pavé tactile.
Ne tapez pas l’écran tactile avec des gants.
Il peut mal fonctionner si vous utilisez vos ongles ou un autre objet comme un stylo 
à bille.

REMARQUE
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CHARGEMENT DE LA PILE
Chargez-la avant d’utiliser votre lecteur pour la première fois et lorsqu’il n’a pas 
été utilisé pour une période prolongée.
Charger le bloc-piles de votre lecteur MP3 prend environ 3 heures ; la durée 
totale du chargement peut varier en fonction des conditions de votre ordinateur.

1. Branchez la grande fi che du câble USB sur la prise du port USB située sur le 
dessous du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.

2

Affi chage à l’écran
<USB connected> 
(Branché USB)

< > - Sous charge

< > - Pleine charge

1
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ENTRETIEN DE LA PILE
Suivre ces simples conseils d’entretien et de rangement prolongera la durée de 
votre bloc-piles.
• Rechargez et rangez l’appareil dans un lieu où la température demeure entre 

5 et 35 °C (40 et 95 °F).
• Évitez de surcharger la batterie (12 heures au maximum). Charger ou décharger 

la batterie à des fréquences trop rapprochées peut réduire sa durée de vie.
• Comme pour tout autre produit de consommation, la durée de vie de la 

batterie raccourcit progressivement avec le temps.

Si vous chargez le lecteur pendant qu’il est branché sur un ordinateur portable, 
veillez à ce que la pile du portable soit aussi complètement chargée ou qu’il soit 
branché sur une source d’alimentation.

MISE SOUS ET HORS TENSION DE L’APPAREIL
Mise sous tension de l’appareil
Faites coulisser le commutateur [ ] vers le bas 
du lecteur et maintenez.

L’appareil s’allume.

Mise hors tension de l’appareil
Faites coulisser à nouveau le commutateur [ ]
vers le bas du lecteur et maintenez.

Le lecteur s’éteint.
Votre lecteur MP3 s’éteindra automatiquement si aucune des touches n’est 
actionnée pendant une période spécifi que en mode pause. Le réglage à l’usine 
de la fonction <Auto Power Off> (Extinction auto) est de 1 minute ; vous pouvez 
cependant en modifi er la durée. Reportez-vous à la page 29 pour plus de détails.

REMARQUE

REMARQUE
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LECTURE DE PIÈCES MUSICALES
Téléchargez les fi chiers musicaux sur votre nouveau lecteur MP3 à l’aide du 
logiciel EmoDio. 
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 

sélectionner <Music> (Musique), puis tapez sur la touche 
[Sélection].

3. Sélectionnez le fi chier musical de votre choix en tapant sur 
les touches [Haut, Bas] et [Sélection].

4. Tapez sur la touche [Sélection] pour effectuer la lecture du fi chier musical.
La lecture du fi chier musical est lancée.

Tapez sur [ ] pour vous déplacer vers l’écran précédent. 
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

CONTRÔLE DU VOLUME
Tapez sur la touche [Haut, Bas].

L’icône du contrôle de volume s’affi che.
Le réglage de la dynamique se situe entre 0 et 30.
Tapez sur la touche [Haut] pour augmenter le volume et sur la 
touche [Bas] pour le diminuer.

Music

Rising Sun

02:13 04:28

Music

Rising Sun

02:13 04:28

REMARQUE
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DÉSACTIVATION DES TOUCHES
La fonction de verrouillage désactive toutes les autres touches du 
lecteur MP3. Ainsi, si vous en touchez une par accident pendant 
vos exercices par exemple, votre musique ne s’arrêtera pas.
1. Faites coulisser le commutateur [ ] vers le haut 

du lecteur pour activer la fonction de verrouillage.
2. Faites coulisser le commutateur [ ] vers le bas 

du lecteur pour désactiver la fonction de verrouillage.

NAVIGUER DANS LES FICHIERS À L’AIDE DU 
“DOSSIER NAVIGATEUR”
Recherchez des fi chiers en toute simplicité grâce la fonction “File Browser”
(Dossier Navigateur).
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 

sélectionner <File Browser> (Dossier Navigateur), puis 
tapez sur la touche [Sélection].

La liste des dossiers <File Browser> (Dossier Navigateur) 
contenant des fi chiers musicaux, des listes de lecture, des fi chiers 
vidéo, des images, des listes de diffusion, des textes, des jeux, 
des fi chiers enregistrés et Mon pack apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le dossier souhaité.
4. Tapez sur la touche [Sélection] pour accéder à la liste des fi chiers dans le 

dossier sélectionné.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.

5. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier souhaité.
6. Tapez sur la touche [Sélection].

La lecture du fi chier débute.

Music

Rising Sun

02:13 04:28
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SUPPRIMER DES FICHIERS À L’AIDE DU “DOSSIER 
NAVIGATEUR”
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 

sélectionner <File Browser> (Dossier Navigateur), puis 
tapez sur la touche [Sélection].

La liste de dossiers du <File Browser> (Dossier Navigateur) 
s’affi che.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le 
dossier souhaité, puis tapez sur [Sélection].

4. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier que vous 
souhaitez supprimer, puis sur [ ].

5. Tapez sur la touche [Haut, Bas] pour sélectionner <Delete> (Supprimer), 
puis tapez sur [Sélection].

La fenêtre de confi rmation pour revenir à la première page s’affi che.

6. Tapez sur la touche [Gauche, Droite] pour sélectionner <Yes> (Oui), puis 
tapez sur la touche [Sélection].

Le fi chier est supprimé.

Les fi chiers ne peuvent pas être récupérés une fois supprimés.

Le fi chier en cours ne sera pas supprimé.
Les fi chiers DNSe transférés par <EmoDio> sont stockés dans le dossier <My 
Pack> (Mon pack) groupée du répertoire <File Browser> (Dossier Navigateur).
Reportez vous à <EmoDio> pour plus de détails sur les fi chiers DNSe.

REMARQUE

File Browser

Music
Playlists
Video
Pictures
Datacasts
Texts
Games
Recorded Files
My Pack

ATTENTION
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES
Votre lecteur MP3 comprend des réglages et des préférences défi nis par défaut, 
mais vous pouvez les modifi er selon votre goût afi n de personnaliser votre lecteur.

Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

Réglage du style de menu
Vous pouvez modifi er les polices et le modèle du menu et supprimer le 
fond d’image du menu principal.
1. Appuyez longuement sur [ ] pour vous déplacer 

sur l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite]

pour sélectionner <Settings> (Paramètres), puis 
tapez sur la touche [Sélection].

Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Menu Style> (Style du menu), puis tapez sur la 
touche [Sélection].

Le menu <Menu Style> (Style du menu) apparaît.

4. Les touches [Haut, Bas] et [Sélection] servent à régler les fonctions.
Tapez sur la touche [Sélection] pour passer à l’élément/menu suivant.
Tapez sur la touche [Haut, Bas] pour vous déplacer vers le haut ou vers le 
bas dans le menu actuel.

Options de réglage du style de menu
Menu Design (Aspect du menu) : Pour modifi er le style d’écran du menu 
principal. Sélectionnez entrei <Matrix> (Matrice) et <My Skin> (Mon habillage). 
Font (Police) : Pour modifi er la police de la langue des menus. Sélectionnez parmi 
3 polices. Certaines langues des menus n’affi chent pas la fonction <Font> (Police).
Reset My Skin (Réinitialiser mon habillage) : Pour recomposer le fond d’image 
de l’écran tactile à sa valeur par défaut.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System

REMARQUE
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres du son
Vous pouvez régler l’égaliseur principal, le signal sonore et l’intensité du 
volume sonore.
1. Appuyez longuement sur [ ] pour vous déplacer 

sur l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite]

pour sélectionner <Settings> (Paramètres), puis 
tapez sur la touche [Sélection].

Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Sound> (Son), puis tapez sur la touche [Sélection].

Le menu <Sound> (Son) apparaît.

4. ULes touches [Haut, Bas] et [Sélection] servent à régler les fonctions.

Sound Setting Options
Master EQ (EG princ.) : Pour optimiser les paramètres sonores.
Tapez sur la touche [Gauche, Droite] pour sélectionner la fréquence que vous 
souhaitez paramétrer. Tapez sur la touche [Haut, Bas] pour régler le niveau de 
la fréquence sélectionnée, puis tapez sur la touche [Sélection].
Beep Sound (Signal sonore) : Permet d’activer ou de désactiver l’émission d’un 
signal sonore lors des opérations effectuées sur l’écran tactile. Choisissez entre 
<Off> (Arrêt) et <On> (Marche).
Volume Limit (Limitation du Volume) : Permet d’éviter les problèmes de l’ouïe 
en réglant la limite du volume sonore lorsque vous utilisez les écouteurs. 
<On> (Marche) limite le volume sonore à un niveau maximum de15. Le niveau 
maximum du volume est de 30 lorsque la fonction de limite est sur <Off> (Arrêt). 
Afi n d’éviter les troubles de l’ouïe, le niveau du volume revient sur 15 lorsque 
vous rallumez le lecteur même si vous aviez désactivé la limite <Off> (Arrêt).

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres de l’écran
Permet de modifi er la période avant l’extinction et la luminosité de votre 
écran.
1. Appuyez longuement sur [ ] pour vous déplacer 

sur l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite]

pour sélectionner <Settings> (Paramètres), puis 
tapez sur la touche [Sélection].

Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionne 
<Display> (Affi cher), puis tapez sur la touche 
[Sélection].

Le menu <Display> (Affi cher) apparaît.

4. Les touches [Haut, Bas] et [Sélection] servent à régler les fonctions.

Options de réglage de l’écran
Display Off (Affi ch. Désactivé) : Si aucune touche n’est activée durant les 
périodes indiquées plus bas, l’écran s’éteint automatiquement. Vous pouvez 
choisir entre <15sec>, <30sec>, <1min>, <3min>, <5min>, et <Always On> 
(Toujours allumé). Appuyez sur n’importe quelle touche pour rallumer l’écran. 
Brightness (Luminosité) : Vous pouvez régler la luminosité de l’écran. 
Sélectionnez un niveau entre <0 et 10>, 10 étant le plus lumineux.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres de la langue
Les menus de votre nouveau lecteur MP3 peuvent être réglés de façon 
à apparaître dans plusieurs langues. Il est très facile de changer la 
langue selon votre choix.
1. Appuyez longuement sur [ ] pour vous déplacer 

sur l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite]

pour sélectionner <Settings> (Paramètres), puis 
tapez sur la touche [Sélection].

Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Language> (Langue), puis tapez sur la touche 
[Sélection].

La liste des langues s’affi che.
<English>, <한국어>, <Français>, <Deutsch>, <Italiano>, <日本語>, <

>, < >, <Español>, < >, <Magyar>, <Nederlands>, 
<Polski>, <Português>, <Svenska>, < >, < eština>, < >,
<Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español (Sudamérica)>, 
<Português (Brasil)>, <Indonesia>, <Ti ng Vi t>, <Bulgarian>, <Român >,
< >, <Slovenš ina>, <Slovenský>.

4. Tapez sur la touche [Haut, Bas] pour sélectionner la langue 
souhaitée, puis tapez sur la touche [Sélection].

Les langues prises en charge peuvent être modifi ées ou ajoutées.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System

REMARQUE
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Réglage de l’horodatage
pour régler la date et l’heure actuelle.
1. Appuyez longuement sur [ ] pour vous déplacer sur l’écran du 

menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite]

pour sélectionner <Settings> (Paramètres), puis 
tapez sur la touche [Sélection].

Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Date&Time> (Date et heure), puis tapez sur la 
touche [Sélection].

L’écran de l’horodatage apparaît.

4. Tapez sur la touche [Gauche, Droite] pour accéder à <Year, Month, 
Date, Hour, Min, AM/PM> (An, mois, jour, heure, minutes AM/PM), 
puis tapez sur la touche [Haut, Bas] pour régler chaque élément.

5. Tapez sur la touche [Sélection].
La fenêtre de confi rmation apparaît.

6. Tapez sur la touche [Gauche, Droite] pour sélectionner <Yes> (Oui), 
puis tapez sur la touche [Sélection].

La date et l’heure sont enregistrées.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Paramètres du système
Choisissez les réglages par défaut qui vous conviennent pour les 
fonctions alarme, mode de mise en marche et de mise hors tension 
automatique.
1. Appuyez longuement sur [ ] pour vous déplacer 

sur l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite]

pour sélectionner <Settings> (Paramètres), puis 
tapez sur la touche [Sélection].

Le menu <Settings> (Paramètres) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<System> (Système), puis tapez sur la touche 
[Sélection].

Le menu <System> (Système) apparaît.

4. Les touches [Haut, Bas] et [Sélection] servent à régler les fonctions.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Options de réglage du système

My Profi le (Mon profi l) : Permet d’enregistrer votre nom et votre date de naissance. 
Reportez-vous en page 30 et 31.
Sleep (Veille) : Permet d’éteindre automatiquement l’appareil après l’écoulement de la 
durée présélectionnée. Choix disponibles : <Off> (Arrêt), <15min >, <30min>, <60min>, 
<90min> ou <120min>.
Start Mode (Mode de mise en marche) : Permet de choisir le mode à affi cher à l’allumage 
du lecteur. Sélectionnez entre <Main Menu> (Menu principal) et <Last State> (Dernier 
état). Sélectionnez <Main Menu> (Menu principal) pour démarrer le système en affi chant 
le menu principal et <Last State> (Dernier état) pour affi cher le denier écran utilisé.
Auto Power Off (Mise hors tension automatique) : L’appareil s’éteint automatiquement 
en mode Pause ; aucune activation de touche pendant la durée préréglée. Sélectionnez 
parmi : <15sec>, <30sec>, <1min>, <3min>, <5min> et <Always On> (Toujours allumé).
Default Set (Réglages par défaut) : Permet de revenir aux valeurs de réglage par défaut. 
Options disponibles :  <Yes> (Oui) ou <No> (Non). <Yes> (Oui) permet d’initialiser tous les 
réglages par défaut.  <No> (Non) permet d’annuler les réglages par défaut.
Format (Formater) : Permet de formater la mémoire interne. Options disponibles :  <Yes> 
(Oui) ou <No> (Non). <Yes> (Oui) formate la mémoire interne et supprime tous les fi chiers 
du lecteur. <No> (Non) prévient le formatage de la mémoire interne. Vérifi ez avant de 
formater.
About (À propos de): Tapez sur la touche [Gauche, Droite] pour contrôler la version du 
micrologiciel, le nombre de fi chiers enregistrés et la mémoire restante.
<Firmware Ver.> (Version du fi rmware) affi che la version de micrologiciel courante.
<Memory> (Mémoire) - <Used> (Utilisée) indique l’usage, <Remaining> (Mémoire 
Restante) indique la capacité restante et <Total> (Totale) indique la capacité totale de 
mémoire.
<Files> (Fichiers) - Permet de vérifi er le nombre de fi chiers musicaux, vidéo, images, 
textes et le nombre total de fi chiers.
Demo Mode (Mode Démo) : Si vous le réglez sur <On> (Marche) le lecteur répète la 
lecture de l’extrait d’introduction du produit dans le dossier vidéo.
Tapez sur la touche tactile pour revenir à l’écran précédent.

À propos de la mémoire intégrée
1 Go = 1.000.000.000 d’octets : la capacité formatée réelle peut être inférieure puisque 
le micrologiciel utilise une partie de la mémoire.

REMARQUE
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Enregistrer votre nom

1. Tapez sur la touche [Haut, Bas] pour sélectionner 
<My Profi le> (Mon profi l), puis tapez sur la touche 
[Sélection].

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<My Name> (Mon nom), puis tapez sur la touche 
[Sélection].

La fenêtre de modifi cation de votre nom apparaît.

3. Utilisez les touches [Haut, Bas, Gauche, Droite] et 
[Sélection] pour modifi er le nom.

[  ] : Le mode d’entrée bascule entre les majuscules anglaises, les 
minuscules anglaises et les numéros.

[  ] : Vous pouvez supprimer les caractères un à un.
[  ] : Vous pouvez insérer le caractère « – ».
[  ] : Confi rmez la modifi cation.
Une fois l’enregistrement de votre nom terminé, celui-ci s’affi che au 
démarrage.

Rename My ..

_
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (Suite)
Enregistrer votre date de naissance

Avant de démarrer – En premier lieu, réglez l’horloge à l’heure actuelle. 
Reportez-vous à la page 27.

1. Tapez sur la touche [Haut, Bas] pour sélectionner 
<My Profi le> (Mon profi l), puis tapez sur la touche 
[Sélection].

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<My Birthday> (Mon anniv.), puis tapez sur la 
touche [Sélection].

La fenêtre de modifi cation de votre date de naissance 
apparaît.

3. Tapez sur la touche [Gauche, Droite] pour accéder à <Year, Month, 
Date> (An, mois, jour), puis tapez sur la touche [Haut, Bas] pour 
régler chaque élément.

4. Tapez sur la touche [Sélection].
Une fois l’enregistrement de votre date de naissance terminé, celle-ci 
s’affi che au démarrage.

Edit My Birth..
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RÉINITIALISER LE SYSTÈME
Ils sera possiblement nécessaire de réinitialiser le système s’il devient 
impossible d’allumer votre lecteur MP3, s’il ne lit pas la musique ou s’il n’est pas 
reconnu par votre ordinateur lorsque vous le branchez.

N’insérez jamais d’objet pointu dans le trou du microphone. Cela peut endommager 
le produit.ATTENTION

Appuyez sur la touche Reset situé sur la 
partie inférieure de l’appareil à l’aide d’un 
objet pointu, comme une un trombone.

Le système est réinitialisé.
Cela n’affecte pas vos réglages ou vos fi chiers.
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EmoDio
EmoDio est un logiciel d’application fourni avec le lecteur MP3 offrant 
divers services reliés au contenu ainsi que des outils de soutien.

BESOINS DE L’ORDINATEUR
Votre ordinateur doit être conforme aux spécifi cations minimales suivantes pour 
que vous puissiez installer et exécuter EmoDio:
• Pentium 500 MHz ou plus
• Port USB 2.0
• Windows XP Service Pack 2 ou 

ultérieur
• DirectX 9.0 ou version ultérieure
• 100 Mo d’espace libre sur le disque 

dur

• Lecteur de CD-Rom (2X ou plus)
• Windows Media Player 10,0 ou 

ultérieur
• Résolution 1024 X 768 ou plus
• Internet Explorer 6.0 ou ultérieur
• 512 Mo de mémoire vive ou plus

Ne débranchez jamais le câble USB durant le transfert de fi chiers. Le débrancher 
durant le transfert peut endommager le lecteur ou votre ordinateur.
Pour éviter les connexions instables, branchez le lecteur directement sur votre 
ordinateur plutôt que par le biais d’un répéteur multiport USB.

Toutes les fonctions sont désactivées durant le branchement.
Il est conseillé d’utiliser le système de fi chiers FAT 32 pour formater le lecteur sur un 
ordinateur.Avec Windows Vista, cliquez sur Restaurer la confi guration par défaut, 
puis formatez-le.

ATTENTION

REMARQUE
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INSTALLATION DE EMODIO
Assurez-vous que le programme d’installation <EmoDio> a été lancé sur le compte 
administrateur de votre ordinateur.
Dans le cas contraire, <EmoDio> ne pourra pas être installé. Pour trouver le compte 
administrateur, veuillez vous référer au manuel 
d’utilisation de votre ordinateur.

1. Insérez le CD d’installation fourni avec le 
lecteur dans le lecteur de CD-ROM de votre 
ordinateur.

2. Cliquez sur <Install now> (Installer 
maintenant).

Suivez les instructions pour lancer l’installation.
L’installation de <EmoDio> démarre et une icône  s’affi che sur votre Bureau à la fi n 
de l’installation.

Soyez prudent lorsque vous insérez le CD d’installation dans un lecteur CD-ROM à 
la verticale.

La technologie de reconnaissance musicale et les données relatives sont fournies 
par Gracenote et Gracenote CDDB® Music Recognition ServiceSM.
CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, 
le logo et le logotype Gracenote CDDB et le logo “Powered by Gracenote CDDB” 
sont des marques déposées de Gracenote. Music Recognition Service et MRS sont 
des marques de service de Gracenote. 

ATTENTION

REMARQUE

ATTENTION
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COMMENT UTILISER EMODIO
Ils sera possiblement nécessaire de réinitialiser le système s’il devient 
impossible d’allumer votre lecteur MP3, s’il ne lit pas la musique ou s’il n’est pas 
reconnu par votre ordinateur lorsque vous le branchez.

Le logiciel EmoDio est la méthode la plus facile d’effectuer un 
transfert de fi chier de votre ordinateur sur votre lecteur MP3.

EmoDio vous permet de créer votre propre collection ou album de 
fi chiers audio. 

Il permet le transfert de vos données de blogue et des fi chiers 
enregistrés au format RSS sur le lecteur pour votre plaisir.

Il s’agit d’un service communautaire en ligne pour les utilisateurs 
d’EmoDio.com.
Il offre un service simple de téléchargement en amont et en aval pour vos 
contenus réalisés à l’aide du logiciel EmoDio ainsi que plusieurs façons 
de partager vos anecdotes avec d’autres utilisateurs de la communauté.

Pour plus de détails sur le logiciel EmoDio, cliquez sur <MENU> (Menu) <Help>
(Aide) <Help> (Aide) au haut de l’écran.REMARQUE
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écoute de la musique
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

ÉCOUTE PAR CATÉGORIE

1. Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu 
principal.

2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour sélectionner <Music>
(Musique), puis tapez sur la touche [Sélection].

La liste de musique s’affi che.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la liste souhaitée, puis 
tapez sur la touche [Sélection].

Le fi chier musical apparaît.

4. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier à lire, puis tapez 
sur la touche [Sélection].

La lecture de la musique démarre.

Music

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Music

Rising Sun

02:13 04:28

REMARQUE
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ÉCOUTE PAR CATÉGORIE (Suite)
Liste de fi chiers musicaux
Les renseignements reliés au fi chier incluant le nom de l’artiste, le nom de l’album, le 
titre de la pièce musicale et son genre s’affi chent en fonction de l’étiquette ID3 du fi chier 
musical approprié. Un fi chier sans étiquette ID3 s’affi che comme [unknown] (inconnu).
Now Playing (En Lecture) : Lit un fi chier récemment lu ou se déplace sur l’écran de lecture 
du fi chier actuel.
Artists (Artiste) : Lecture par artiste
Albums (Albums) : Lecture par album. Tapez sur [ ] pour sélectionner <List Type> (Type 
de liste). Sélectionnez <Album Art> (Image CD) pour affi cher à la fois l’image de la page 
couverture et le titre de l’album ou sélectionnez <List> (Liste) pour affi cher uniquement le 
titre de l’album.
Songs (Chansons) : Lecture en ordre numérique ou alphabétique
Genres (Genres) : Lecture par genre 
Playlists (Listes de lecture) : Lecture par liste
Recorded Files (Fichiers Enregistrés) : Affi che les fi chiers enregistrés.
Music Browser (Navig. musique) :Affi che tous les fi chiers musicaux stockés dans le 
dossier Musique.

Les fi chiers musicaux MP3 et WMA sont compatibles avec votre lecteur.
Les fi chiers MP1 ou MP2 possédant uniquement une extension modifi ée vers MP3 
peuvent ne pas être lus.
Si vous débranchez les écouteurs durant la lecture de musique, le lecteur passera 
en mode Pause.
Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives 
au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ 
commentaire.

REMARQUE
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PAUSE
1. Tapez sur la touche [Sélection] en cours de lecture.

La lecture de la musique est interrompue.

2. Tapez à nouveau sur la touche [Sélection].
La lecture reprend à l’endroit où vous l’avez suspendue.

RECHERCHE SUR UNE PISTE
1. Appuyez longuement sur la touche [Gauche, Droite] en cours de lecture de la 

piste sélectionnée.
Ces touches permettent d’effectuer la recherche vers le début ou la fi n de la piste.

2. Relâchez la touche dès que vous souhaitez reprendre la lecture.
La lecture commence dès que vous relâchez la touche.

LECTURE DE LA PISTE EN COURS À PARTIR DU DÉBUT
Tapez sur la touche [Gauche] après 3 secondes de lecture.

La piste en cours est lue à partir du début.

POUR ÉCOUTER LA PISTE PRÉCÉDENTE
Tapez sur la touche [Gauche] dans les 3 premières secondes de lecture.
Tapez deux fois sur la touche [Gauche] après 3 secondes de lecture.

La lecture de la piste précédente démarre.
Pendant la lecture de fi chiers VBR, la piste précédente peut ne pas être lue même 
si vous tapez sur la touche [Gauche] au cours des 3 premières secondes de lecture.

LECTURE DE LA PLAGE SUIVANTE
Tapez sur la touche [Droite].

La lecture de la piste suivante démarre.

ATTENTION
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POUR CRÉER UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3
Si vous avez déjà téléchargé des fi chiers sur le lecteur MP3, vous pouvez créer 
une liste de vos fi chiers favoris.

1. Appuyez longuement sur [ ] pour vous déplacer sur 
l’écran du menu principal.

2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 
sélectionner <File Browser> (Dossier Navigateur), puis 
tapez sur la touche [Sélection].

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Music> (Musique), puis tapez sur la touche [Sélection].

Le(s) fi chier(s) musical/musicaux s’affi che (nt).

4. Tapez sur la touche [Haut, Bas] pour sélectionner un fi chier à ajouter à la 
liste de lecture, puis sur [ ].

Le menu de la liste de lecture apparaît.

5. Tapez sur la touche [Haut, Bas] pour sélectionner <Add to Playlist>
(Aj. à liste lect.), puis tapez sur la touche [Sélection].

<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) apparaît.

6. Tapez sur la touche [Haut, Bas] pour sélectionner un numéro de liste de 
lecture pour ajouter le fi chier sélectionné, puis tapez sur la touche [Sélection].

Le fi chier sélectionné sera ajouté à liste de lecture.
Vous pouvez vérifi er la liste de lecture dans <Music> (Musique)  <Playlists> (Listes de 
lecture)  <Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) du menu principal.

Vous pouvez ajouter jusqu’à 100 fi chiers musicaux dans chaque liste de lecture 
(<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5)).
Reportez-vous au logiciel EmoDio pour plus de détails sur la création d’une liste de 
lecture et pour la transférer sur le lecteur.

Music

Rising Sun
My love

Add to Playlist
Delete

1/2

REMARQUE
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LECTURE D’UNE LISTE DE LECTURE
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 

sélectionner <Music> (Musique), puis tapez sur la touche 
[Sélection].

La liste de musique s’affi che.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Playlists> (Playlist), puis tapez sur la touche [Sélection].

La/Les liste(s) de lecture s’affi che(nt).

4. Tapez sur la touche [Haut, Bas] pour sélectionner la liste de lecture de votre 
choix, puis tapez sur la touche [Sélection].

Les fi chiers musicaux enregistrés dans la liste de lecture sélectionnée s’affi chent.
Si une liste de lecture n’est pas trouvée, le message <No File> (Aucun fi chier) s’affi che 
à l’écran.

5. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier à lire, puis tapez 
sur la touche [Sélection].

La lecture du fi chier musical débute.

Music

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser
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POUR SUPPRIMER UN FICHIER DE LA LISTE DE LECTURE
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour sélectionner 

<Music> (Musique), puis tapez sur la touche [Sélection].
La liste de musique s’affi che.

3. Tapez sur la touche [Haut, Bas] pour sélectionner <Playlists>
(Playlist), puis tapez sur la touche [Sélection].

La/Les liste(s) de lecture apparaît(nt).

4. Tapez sur la touche [Haut, Bas] pour sélectionner la liste de 
lecture de votre choix, puis tapez sur la touche [Sélection].

Les fi chiers musicaux enregistrés dans la liste de lecture 
sélectionnée s’affi chent.

5. Tapez sur la touche [Haut, Bas] pour sélectionner un fi chier à 
supprimer de la liste de lecture, puis sur [ ].

Le menu de la liste de lecture apparaît.

6. Tapez sur la touche [Haut, Bas] pour sélectionner<Delete from 
Playlist> (Suppr. de liste lect.), puis tapez sur [Sélection].

Le fi chier sélectionné est supprimé de la liste de lecture.

POUR SUPPRIMER TOUS LES FICHIERS DE LA LISTE DE LECTURE
Suivez les étapes 1 à 4 ci-dessus.
5. Tapez sur [ ].

Le menu de la liste de lecture apparaît.

6. Tapez sur la touche [Haut, Bas] pour sélectionner <Delete All 
from Playlist> (Suppr. tt de liste lect.), puis tapez sur [Sélection].

Tous les fi chiers sont supprimés de la liste de lecture.
Il est impossible de supprimer le fi chier sélectionné alors qu’il 
est en cours de lecture.

Playlists

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5

Playlist 1

Rising Sun
My love

1/2

Delete from Playlist
Delete All from Playli..

Playlist 1

Rising Sun
My love

1/2

Delete from Playlist
Delete All from Playlist

REMARQUE
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POUR UTILISER LE MENU MUSIQUE
Le menu Musique vous permet d’organiser tous les aspects de l’écoute en 
cours de lecture – depuis la lecture en boucle de pistes et d’albums à la 
sélection du fond d’écran.

Pour régler les effets sonores
Pour profi ter d’un son plus clair.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Sound Effect> (Effets Sonores), puis tapez sur 
la touche [Sélection].

Le menu <Sound Effect> (Effets Sonores) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
l’effet sonore souhaité, puis tapez sur la touche 
[Sélection].

Sélectionnez entre <Street Mode> (Mode rue) et <Audio Upscaler> 
(Interpolation audio).

Options des effets sonores
Street Mode (Mode Rue) : Pour écouter de la musique plus nette en extérieur 
en fi ltrant certains bruits de la rue. Sélectionnez de 0 à 2.
Audio Upscaler (Interpolation audio) : Cette fonction permet de restituer une 
source sonore perdue lors de l’encodage au format WMA / MP3 dans sa forme 
quasi originale. L’interpolation audio ne fonctionne qu’avec les fi chiers de 
mauvaise qualité. Options disponibles : <On> (Marche) ou <Off> (Arrêt).

Tapez sur [ ] pour quitter le menu.
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POUR UTILISER LE MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe)
Permet de choisir le type de son convenant le mieux à chaque genre de 
Musique.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<DNSe>, puis tapez sur la touche [Sélection].

Le menu <DNSe> apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
le mode DNSe souhaité, puis tapez sur la touche 
[Sélection].

Sélectionnez parmi <Auto>, <Normal>, <Studio>, <Rock>, <Classical> 
(Classique), <Jazz>, <Ballad> (Ballade), <Club>, <Rhythm & Blues> (R&B), 
<Dance> (Danse), <Café>, <Concert>, <Church> (Église ) et <myDNSe>.
<Auto> (Auto.) sélectionne automatiquement le mode DNSe correspondant 
si l’information contenant le genre de musique est contenu sur l’étiquette ID3 
du fi chier musical.
Réglez le mode utilisateur DNSe en sélectionnant <myDNSe>. 
Reportez-vous à la page 44.

Qu’est-ce que l’engin DNSe ?
Digital Natural Sound Engine (Engin de son naturel numérique) (DNSe) est 
un effet sonore développé par Samsung pour les lecteurs MP3.  
Cette option offre différents réglages sonores visant à améliorer le type de 
musique que vous écoutez.
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour sélectionner myDNSe
Vous pouvez soit paramétrer l’option User DNSe (DNSe utilisateur) 
sur votre lecteur ou régler l’option correspondante transférée depuis 
<EmoDio>.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<DNSe>, puis tapez sur la touche [Sélection].

Le menu <DNSe> apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
<myDNSe>, puis tapez sur la touche [Sélection].

La liste des modes utilisateur DNSe apparaît.

4. Tapez sur la touche [Haut, Bas] pour sélectionner le mode DNSe 
souhaité, puis tapez sur la touche [Sélection].

Le mode utilisateur DNSe est activé.
L’option <myDNSe> permet de défi nir les options utilisateur <EQ> 
(Égalisateur), <3D & BASS>, <Concert Hall> (Salle concert) et <Clarity> 
(Netteté). Voir en page 45 à 48.

Reportez-vous à EmoDio pour plus de détails sur la confi guration d’un 
mode utilisateur DNSe pour ce logiciel.
Vous pouvez transférer jusqu’à 97 modes utilisateur DNSe sur le lecteur 
excluant <User 1> (Utilisateur 1) à <User 3> (Utilisateur 3).
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour sélectionner myDNSe (Suite)

<EQ> (EG)
Vous pouvez ajuster des fréquences particulières selon vos préférences.
1. Tapez sur la touche [Haut, Bas] dans le menu 

myDNSe pour sélectionner le mode utilisateur DNSe 
souhaité, puis tapez sur [ ].

Le menu des modes utilisateur DNSe apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<EQ> (EG), puis tapez sur la touche [Sélection].

L’écran de réglage de <EQ> (EG) apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner la fréquence que vous souhaitez régler, puis sur 
la touche [Haut, Bas] pour régler le niveau de la fréquence 
sélectionnée.

Vous pouvez régler le niveau de la fréquence sélectionnée de <–10 ~ +10> 
(–10 à +10).

4. Tapez sur la touche [Sélection].
Le réglage est terminé.

myDNSe

User 1
User 2
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EQ
3D & BASS
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Clarity
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour sélectionner myDNSe (Suite)

<3D & BASS>
Vous pouvez régler l’effet sonore 3D et l’amplifi cation des basses 
fréquences.
1. Tapez sur la touche [Haut, Bas] dans le menu 

myDNSe pour sélectionner le mode utilisateur DNSe 
souhaité, puis tapez sur [ ].

Le menu des modes utilisateur DNSe apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<3D & BASS>, puis tapez sur la touche 
[Sélection].

L’écran de réglage de <3D & BASS> apparaîts.

3. Tapez sur la touche [Gauche, Droite] pour sélectionner <3D> ou 
<BASS>, puis tapez sur la touche [Haut, Bas].

Vous pouvez sélectionner un niveau <3D> et <Bass> compris entre <0 et 4>.

4. Tapez sur la touche [Sélection].
Le réglage est terminé. 

myDNSe
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour sélectionner myDNSe (Suite)

<Concert Hall>(Salle concert)
Permet de défi nir les dimensions de la salle de concert et le niveau 
sonore comme pour une salle de concert réelle.
1. Tapez sur la touche [Haut, Bas] dans le menu 

myDNSe pour sélectionner le mode utilisateur DNSe 
souhaité, puis tapez sur [ ].

Le menu des modes utilisateur DNSe apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Concert Hall> (Salle concert), puis tapez sur la 
touche [Sélection].

L’écran de confi guration de l’option <Concert Hall>
(Salle concert) apparaît.

3. Tapez sur la touche [Gauche, Droite], sélectionnez <Size>
(Dimensions) ou <Level> (Niveau sonore), puis tapez sur la touche 
[Haut, Bas].

Vous pouvez sélectionner une valeur comprise entre <0 et 3> pour les 
options <Size> (Dimensions) et <Level> (Niveau sonore).

4. Tapez sur la touche [Sélection].
Le réglage est terminé.

Sélectionner <Concert Hall> (Salle concert) peut désactiver certains autres 
effets sonores en fonction du fi chier musical.

myDNSe
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User 2
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour sélectionner myDNSe (Suite)

<Clarity> (Netteté)
Pour écouter une musique plus nette à qualité améliorée. 
1. Tapez sur la touche [Haut, Bas] dans le menu 

myDNSe pour sélectionner le mode utilisateur DNSe 
souhaité, puis tapez sur [ ].

Le menu des modes utilisateur DNSe apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Clarity> (Netteté), puis tapez sur la touche 
[Sélection].

L’écran de confi guration <Clarity> (Netteté) apparaît.
Sélectionnez un niveau compris entre <0 et 2>.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le niveau 
souhaité, puis tapez sur la touche [Sélection].

Le réglage est terminé.

myDNSe

User 1
User 2
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour régler le mode de lecture
Sélectionnez un mode de lecture tel que Répéter.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Play Mode> (Mode lecture), puis tapez sur la 
touche [Sélection].

Le menu <Play Mode> (Mode lecture) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
le mode de lecture souhaité, puis tapez sur la 
touche [Sélection].

Options du mode de lecture
Normal : Lecture ponctuelle et dans l’ordre de toutes les pistes.
Repeat (Répéter) : Lecture en boucle de tous les fi chiers de la liste de musique 
en cours.
Repeat One (Répéter 1X) : Lecture en boucle d’un fi chier.
Shuffl e (Aléatoire) : Lecture aléatoire et en boucle de tous les fi chiers de la liste 
de musique en cours.
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour sélectionner l’écran de lecture musicale
Faites le choix d’un fond d’écran parmi ceux disponibles ou choisissez 
votre propre image à affi cher lorsque vous écoutez de la musique.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Music Play Screen> (Écran lect mus.), puis 
tapez sur la touche [Sélection].

Le menu <Music Play Screen> (Ecran Lect mus.) apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner l’écran de lecture musicale souhaité, 
puis tapez sur la touche [Sélection].

Options de l’écran de lecture musicale
Sélectionnez parmi les modes <Refl ection> (Réfl exion), <Auto> (Auto.), 
<Passionate> (Passion), <Sweet> (Doux), <Quiet> (Calme), <Cheerful> (Joie), 
<Album Art> (Image CD) et <Album Info.> (Info. Album)
Auto : Change automatiquement l’écran de lecture musicale en fonction de 
l’information contenue sur l’étiquette ID3 du fi chier musical.
Album Art (Image CD) : L’image de la jaquette de l’album s’affi che si elle est 
comprise dans l’information de l’étiquette ID3 du fi chier musical. Les images 
de jaquette de taille moindre que 200 pixels (à l’horizontale) x 200 pixels (à la 
verticale) sont soutenues.
Album Info. (Info.album): Les renseignements comprenant le nom de l’artiste, 
l’album et son genre s’affi chent si l’information de l’étiquette ID3 est stockée sur 
le fi chier musical.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations 
relatives au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un 
champ commentaire. 
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour régler la vitesse de lecture
Vous pouvez accélérer ou ralentir la vitesse de lecture de votre musique 
préférée.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Play Speed>(Vitesse de lecture), puis tapez sur 
la touche [Sélection].

Le menu <Play Speed> (Vitesse de lecture) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
la vitesse de lecture souhaitée, puis tapez sur la 
touche [Sélection].

Sélectionnez parmi <Slow3> (Lent 3), <Slow2> (Lent 2), <Slow1> (Lent 1),l 
<Normal> (Normal), <Fast1> (Rapide 1), <Fast2> (Rapide 2) et <Fast3> 
(Rapide 3).
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POUR UTILISER LE MENU MUSIQUE (Suite)
Pour régler le saut d’intervalle
Vous pouvez vous déplacer à marche avant rapide dans un fi chier à 
différents intervalles. Vous pouvez sauter une piste entière ou plusieurs 
secondes à la fois.
1. Tapez sur [ ] tout en écoutant la musique.

Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Skip Interval> (Saut intervalle), puis tapez sur la 
touche [Sélection].

Le menu <Skip interval> (Saut Intervalle) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
l’intervalle de saut souhaité, puis tapez sur la touche [Sélection].

Choisissez entre <1 Song> (1 chanson), <5sec>, <10sec>, <30sec> et <1min>.

Si le fi chier a été enregistré à débit binaire variable (VBR), la longueur 
réelle du saut peut varier de celle que vous avez sélectionnée.
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POUR UTILISER LE MENU MUSIQUE (Suite)
Défi nir la répétition d’un segment
Cette fonction vous permet d’écouter des parties spécifi ques d’une piste 
d’une façon répétée. Recommandée pour l’apprentissage d’une langue.
1. Tapez sur [ ] arrivé au point souhaité en cours de 

lecture.
Le menu <Music> (Musique) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Repeat A-B Mode On> (Mode Répéter A-B 
activé), puis tapez sur la touche [Sélection].

L’écran de confi guration du mode Répéter apparaît.

3. Tapez sur [ ] au début de la section à répéter.
Le début du segment à répéter est défi ni et le témoin 
< > apparaît sur la barre d’état de lecture.

4. Tapez à nouveau sur [ ] pour défi nir la fi n de la section à répéter.
Le témoin < > apparaît sur la barre d’état de lecture et le segment défi ni est 
lu en boucle.

Annulation de la répétition d’un segment
1. Tapez sur [ ] en cours de répétition de la section.

La répétition du segment est annulée.

La répétition du segment s’annule automatiquement dans les cas suivants.
- Lorsque le début du segment à répéter est défi ni mais que la fi n ne l’est 

pas avant que la piste en cours ne se termine.
- Si le point d’arrêt est réglé sur moins de 3 secondes après le début de la 

répétition.
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pour visionner une vidéo
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez le 
bloc-piles.
Transférer un fi chier vidéo sur le lecteur à l’aide de EmoDio. 
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

POUR VISIONNER UNE VIDÉO
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour sélectionner 

<Videos> (Vidéos), puis tapez sur la touche [Sélection].
La liste des vidéos apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la vidéo, 
puis tapez sur la touche [Sélection].

Le fi chier vidéo sélectionné commence à défi ler à l’horizontale.

PAUSE
1. Tapez sur la touche [Sélection] en cours de 

lecture de la vidéo.
Le lecteur fait une pause.

2. Tapez à nouveau sur la touche [Sélection].
Le lecteur reprend le visionnement à partir du 
dernier point de pause.

Avant le transfert du fi chier vidéo vers le lecteur à l’aide de la fonction <EmoDio>, le 
fi chier est tout d’abord converti automatiquement au format SVI.
La taille du fi chier est également réglée automatiquement. Reportez vous à 
<EmoDio> pour plus de détails.

REMARQUE

REMARQUE

Touche [Haut, Bas]

Touche [Gauche, Droite]
<En affi chage horizontal>
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POUR VOUS DÉPLACER SUR UNE IMAGE SPÉCIFIQUE
1. En affi chage horizontal, appuyez longuement sur la 

touche [Gauche, Droite].
Ceci vous permet de vous déplacer vers l’avant ou vers 
l’arrière dans le fi chier vidéo.

2. Relâchez la touche lorsque vous aurez atteint la position 
souhaitée.

La lecture de la vidéo démarre à partir de cette position.

POUR VISIONNER LE FICHIER VIDÉO PRÉCÉDENT
Tapez sur la touche [Gauche] dans les 3 secondes suivant 
le démarrage de la lecture du fi chier en cours.
Tapez deux fois sur la touche [Gauche] 3 secondes après 
le démarrage de la lecture du fi chier en cours.

Vous revenez sur la vidéo précédente.

LIRE LE FICHIER VIDEO SUIVANT
Tapez sur la touche [Droite].

Vous passez sur la vidéo suivante.

Video Track 1

Video Track 1

Video Track 2
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POUR UTILISER LE MENU VIDÉO
Réglage d’un signet
Lorsque vous aurez défi ni un signet, vous pourrez facilement cette position.
1. Tapez sur [ ] à la scène souhaitée en cours 

de visionnement.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Add Bookmark> (Ajouter 
signet), puis tapez sur la touche [Sélection].

La position lecture / arrêt actuelle sera ajoutée au signet. 
Le symbole [ | ] s’affi che sur la barre d’état.

Si vous avez déjà mis un signet, la fenêtre « Écraser » apparaît. Si vous 
sélectionnez <Yes> (Oui), le signet déjà mis est supprimé et un nouveau 
signet mis en place.
Un seul signet peut être défi ni par fi chier vidéo et vous pouvez défi nir un 
maximum de 50 signets.

Pour vous déplacer sur (lecture) / supprimer le signet
1. Tapez sur [ ] pour interrompre le visionnement 

en cours.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Go to Bookmark> (Accéd. à 
Signet) ou <Delete Bookmark> (Supprimer 
signet), puis tapez sur la touche [Sélection].

Si vous sélectionnez <Go to Bookmark> (Accéd. à Signet), vous vous 
déplacerez jusqu’au signet sélectionné et la lecture débutera.
<Delete Bookmark> (Supprimer signet) enlève le signet sélectionné du 
fi chier vidéo.

Tapez sur [ ] pour quitter le menu.

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe

REMARQUE

REMARQUE
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POUR UTILISER LE MENU VIDÉO (Suite)
Pour régler la luminosité
Vous pouvez régler la luminosité de l’écran.
1. Tapez sur [ ] pour interrompre le 

visionnement en cours.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Brightness> (Luminosité), puis 
tapez sur la touche [Sélection].

Le menu <Brightness> (Luminosité) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la luminosité 
souhaitée, puis tapez sur [Sélection].

Choisissez entre <0~10>.

Pour régler l’engin Digital Natural Sound engine 
(DNSe) (Engin de son numérique naturel)
Vous pouvez régler la luminosité de l’écran.
1. Tapez sur [ ] pour interrompre le 

visionnement en cours.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <DNSe>, puis tapez sur la 
touche [Sélection].

Le menu <DNSe> apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le mode DNSe 
souhaité, puis tapez sur la touche [Sélection].

Choisissez entre <Normal>, <Drama>(Drame) et <Action>.
Qu’est-ce que l’engin DNSe ?
Digital Natural Sound Engine (Engin de son naturel numérique) (DNSe) est un 
effet sonore développé par Samsung pour les lecteurs MP3. L’engin vous offre 
différentes qualités de son pour améliorer le genre de musique que vous écoutez.

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe
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pour visionner des photos
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie..
Transférer les fi chiers photo sur le lecteur à l’aide de EmoDio.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

POUR VISIONNER DES PHOTOS
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour sélectionner 

<Pictures> (Images), puis tapez sur la touche [Sélection].
La fenêtre de prévisualisation apparaît.

3. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 
sélectionner la photo que vous souhaitez affi cher, puis 
tapez sur la touche [Sélection].

La photo sélectionnée s’affi che.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.

Pour vous déplacer sur la photo 
précédente/suivante
En affi chage horizontal, tapez sur 
la touche [Gauche, Droite].

La photo précédente/suivante s’affi che.
Avant le transfert du fi chier image vers le lecteur 
à l’aide de la fonction <EmoDio>, celui-ci est tout 
d’abord converti automatiquement au format JPG. La taille du fi chier est aussi 
ajustée. Reportez vous à <EmoDio> pour plus de détails.

 s’affi che si l’information de l’onglet des fi chiers JPG est erronée.Certaines 
photos peuvent être lentes à s’affi cher.
Le <File Browser> (Dossier Navigateur) est aussi utile pour rechercher une photo. 
Reportez-vous à la page 21.

Touche [Haut, Bas]

[Left, Right] button
<In horizontal view>

REMARQUE

REMARQUE
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REMARQUE

POUR UTILISER LE MENU PHOTO
Visionner des photos tout en écoutant de la musique 
ou la radio FM
Vous pouvez écouter de la musique ou la radio 
FM tout en visionnant vos photos.
1. Tapez sur [ ] en regardant une image.

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Music On> (Musique activée) 
ou <FM Radio On> (Radio FM activée), puis 
tapez sur la touche [Sélection].

Chaque fois que vous tapez sur <Music On> (Musique activée) ou <FM 
Radio On> (Radio FM activée) les options son activé et son désactivé sont 
sélectionnées à tour de rôle.

Pour visualiser un diaporama
Comment procéder 1
1. Tapez sur la touche [Sélection] en cours de 

visionnement de photos.
L’icône [ ] s’affi chera à l’écran et le lecteur lancera 
le diaporama.

Comment procéder 2
1. En mode prévisionnement d’images, tapez sur [ ].

La fenêtre <Start Slideshow> (Démarrer diaporama) 
s’affi che.

2. Tapez sur la touche [Haut, Bas] pour sélectionner <Start Slideshow>
(Démarrer diaporama), puis tapez sur la touche [Sélection].
 L’icône [ ] s’affi chera à l’écran et le lecteur lancera le diaporama.

Tapez sur [ ] pour quitter le menu.
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POUR UTILISER LE MENU PHOTO (Suite)
Arrêt du diaporama

Comment procéder 1
1. En mode diaporama, tapez sur la touche 

[Sélection].
Le diaporama s’arrête.

Comment procéder 2
1. En mode diaporama, tapez sur [ ].

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour sélectionner <Stop Slideshow>
(Arrêt diaporama), puis tapez sur la touche [Sélection].

Le diaporama s’arrête.

Pour régler la vitesse du diaporama
1. Tapez sur [ ] en mode diaporama.

Le menu Diaporama apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Slideshow Speed> (Vitesse 
diaporama), puis tapez sur la touche 
[Sélection].

Le menu <Slideshow Speed> (Vitesse diaporama) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la vitesse 
souhaitée, puis tapez sur la touche [Sélection].

Sélectionnez parmi : <Fast> (Rapide), <Normal> et <Slow> (Lent).

Stop Sildeshow
Slideshow Speed
Transition Effect

Stop Sildeshow
Slideshow Speed
Transition Effect
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POUR UTILISER LE MENU PHOTO (Suite)
Pour agrandir une photo
Vous pouvez zoumer une photo.
1. Tapez sur [ ] en regardant une image.

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Zoom>, puis tapez sur la 
touche [Sélection].

Le menu <Zoom> apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le facteur de 
zoom souhaité, puis tapez sur la touche [Sélection].

Choisissez entre <100%>, <200%> et <400%>.

4. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour accéder à la 
partie de la photo que vous souhaitez agrandir.

Pour annuler le zoom

Tapez sur la touche [Sélection] sur la vue agrandie de la photo.
La taille initiale revient.

Une grande photo peut prendre beaucoup de temps à s’agrandir.
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POUR UTILISER LE MENU PHOTO (Suite)
Pour faire pivoter l’image
Vous pouvez tourner une image, à votre gré.
1. Tapez sur [ ] en regardant une image.

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Rotate> (Pivoter), puis tapez 
sur la touche [Sélection].

Le menu <Rotate> (Pivoter) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner l’angle souhaité, 
puis tapez sur [Sélection].

Choisissez entre <Left 90°> (Gauch 90°), <Right 90°> (90° droite) et <180°>.

Pour régler la fonction de pivot automatique
Auto Pivot permet de faire pivoter la photo proportionnellement afi n de 
l’affi cher à la taille la plus grande possible.
1. Sélectionnez un fi chier photo à utiliser 

comme fond d’écran, puis tapez sur [ ].
Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Auto Pivot> (Pivot automatique), 
puis tapez sur la touche [Sélection].

Le menu <Auto Pivot> (Pivot automatique) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner <On> (Marche), 
puis tapez sur la touche [Sélection].

Le réglage de l’option Pivot auto. est terminé.
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POUR UTILISER LE MENU PHOTO (Suite)
Pour modifi er l’effet de transition
Il est possible de défi nir l’effet de transition d’une photo à la suivante.
1. Tapez sur [ ] en regardant une image.

Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Transition Effect> (Effet 
de transition), puis tapez sur la touche 
[Sélection].

Le menu des effets de transition apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner l’effet de transition 
souhaité, puis tapez sur la touche [Sélection].

Choisissez parmi <Off> (Arrêt), <Auto> (Auto.), <Cover> (Couvercle), <Fade> 
(Fondu), <Push> (Appuyer), <Split> (Partager), <Blinds> (Caches) et <Zoom>.

Pour sélectionner une photo comme fond d’écran
Vous pouvez utiliser une photo de votre choix comme fond d’écran.
1. Sélectionnez un fi chier photo à utiliser comme fond d’écran, puis 

tapez sur [ ].
Le menu <Pictures> (Images) s’affi che.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner <Select as My Skin> (Sél. 
comme habillage), puis tapez sur la touche 
[Sélection].

La fenêtre de confi rmation apparaît.

3. Tapez sur la touche [Gauche, Droite] pour sélectionner <Yes> (Oui), 
puis tapez sur la touche [Sélection].

La photo sélectionnée est établie comme fond d’écran.

Music On
FM Radio On
Start Sildeshow
Zoom
Rotate
Auto Pivot
Transition Effect
Select as My Skin

Music On
FM Radio On
Start Sildeshow
Zoom
Rotate
Auto Pivot
Transition Effect
Select as My Skin



64 _ lecture de texte

Lecture de texte
Qu’il s’agisse d’un roman, du manuscrit d’une nouvelle histoire ou de 
votre article de recherche, le lecteur MP3 vous laisse le lire… tout en 
écoutant de la musique !

Avant de démarrer-Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Transférer des fi chiers texte sur le lecteur à l’aide de EmoDio.
Défi nir la langue souhaitée pour les textes. Reportez-vous à la page 69.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

LECTURE DE TEXTE
1. Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 

sélectionner <Texts> (Textes), puis tapez sur la touche 
[Sélection].

La liste des fi chiers texte apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier 
texte souhaité, puis tapez sur la touche [Sélection].

Le texte s’affi che à l’écran.
Appuyez longuement sur la touche [Sélection] pour affi cher plein écran.
Appuyez à nouveau longuement sur la touche [Sélection] pour revenir à l’écran précédent.

Pour vous déplacer sur la page précédente/suivante
Tapez sur la touche [Gauche, Droite].

Appuyez longuement sur la touche [Gauche, Droite] pour accéder de manière 
continue à la page précédente/suivante.

Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) 
pour rechercher un fi chier texte. Reportez-vous à la page 21.
Votre lecteur MP3 peut accueillir le format de fi chiers TXT en mode Texte.

REMARQUE

REMARQUE



lecture de texte _ 65

POUR UTILISER LE MENU TEXTE
Lire des textes tout en écoutant de la musique ou la radio FM
Vous pouvez écouter de la musique ou la radio FM tout en lisant vos 
textes.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Music On> (Musique activée) ou <FM Radio 
On> (Radio FM activée), puis tapez sur la touche 
[Sélection].

Chaque fois que vous tapez sur <Music On> (Musique 
activée) ou <FM Radio On> (Radio FM activée) les 
options son activé et son désactivé sont sélectionnées 
à tour de rôle.

Pour revenir à la première page
Procédure à suivre pour lire un texte à partir de la première page.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Go to 1st page> (Aller à la 1ère page), puis tapez 
sur la touche [Sélection].

La fenêtre de confi rmation pour revenir à la première 
page s’affi che.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner <Yes> (Oui), puis tapez sur la touche [Sélection].

Se déplace à la première page.
Tapez sur [ ] pour quitter le menu.
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POUR UTILISER LE MENU TEXTE (Suite)
Pour instaurer un signet
Mettez un signet pour revenir sur ce point dans le texte en tout temps.
1. Tapez sur [ ] à la page souhaitée pendant la 

lecture de textes.
Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Add Bookmark> (Ajouter signet), puis tapez sur 
la touche [Sélection].

L’écran texte actuel possède un signet et le symbole 
[ ] s’affi che dans le coin gauche du haut.

Si vous avez déjà mis un signet, la fenêtre “Écraser” 
apparaît. Si vous sélectionnez <Yes> (Oui), le signet déjà mis est supprimé 
et un nouveau signet mis en place.
Un seul signet peut être mis par fi chier texte et vous pouvez mettre un 
maximum de 50 signets.

Accéder à (lire)/Supprimer un signet
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Go to Bookmark> (Accéd. à Signet) ou <Delete
Bookmark> (Supprimer signet), puis tapez sur la 
touche [Sélection].

Vous accédez au signet sélectionné lorsque vous 
cliquez sur <Go to Bookmark> (Accéd. à Signet) et le 
supprimez du fi chier texte lorsque vous sélectionnez 
<Delete Bookmark> (Supprimer signet).
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POUR UTILISER LE MENU TEXTE (Suite)
Réglage de la couleur de la visionneuse de texte
Choisissez votre couleur préférée pour affi cher le texte.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Text Viewer Color> (Coul. visionn. text), puis 
tapez sur la touche [Sélection].

La fenêtre du menu <Text Viewer Color> 
(Coul. visionn. text) apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner la couleur de visionneuse de texte souhaitée, puis 
tapez sur la touche [Sélection].

Sélectionnez entre <Type 1> jusqu’à <Type 6>.

Pour modifi er la taille de police
Vous pouvez modifi er la taille de la police du texte.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Font Size> (Taille police), puis tapez sur la 
touche [Sélection].

La fenêtre du menu <Font Size> (Taille police) apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner la taille de police souhaitée, puis 
tapez sur la touche [Sélection].

Sélectionnez parmi : <Small> (Petit), <Medium> (Moyen) et <Large>.
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POUR UTILISER LE MENU TEXTE (Suite)
Pour défi nir l’apparence du texte
Le texte peut être vu horizontalement ou à la verticale.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<View Type> (Type d’affi chage), puis tapez sur la 
touche [Sélection].

L’écran <View Type> (Type d’affi chage) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
le genre d’affi chage, puis tapez sur [Sélection].

Sélectionnez <Normal> (Normal) ou <Horizontal> (Horizontal).
Sélectionnez <Normal> (Normal) pour visualiser le texte à la verticale et 
sélectionnez <Horizontal> (Horizontal) pour pivoter l’écran à l’horizontale.
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POUR UTILISER LE MENU TEXTE (Suite)
Pour défi nir une langue de texte
Permet de choisir la langue du texte à visionner.
1. Tapez sur [ ] pendant la lecture du texte.

Le menu <Text> (Texte) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Language> (Langue), puis tapez sur la touche 
[Sélection].

La liste des langues s’affi che.
<English>, <Korean>, <French>, <German>, <Italian>, 
<Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>, 
<Russian>, <Hungarian>, <Dutch>, <Polish>, 
<Portuguese>, <Swedish>, <Thai>, <Finnish>, <Danish>, <Norwegian>, 
<Farsi>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, <Estonian>, 
<Greek>, <Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, <Slovene>, 
<Turkish>, <Vietnamese>.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la langue 
souhaitée, puis tapez sur la touche [Sélection].

Vous pouvez lire le texte dans la langue sélectionnée.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
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POUR UTILISER LE MENU TEXTE (Suite)
Pour écouter un texte de synthèse de la parole (TTS 
-Text to Speech)
La fonction TTS de <EmoDio> vous permet de synthétiser un fi chier 
texte en fi chier TTS afi n de l’écouter.

Avant de démarrer -  Transférer des fi chiers TTS sur le lecteur à l’aide de EmoDio.

1. Appuyez longuement sur [ ] pour vous déplacer sur l’écran du 
menu principal.

2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour sélectionner 
<Texts> (Textes), puis tapez sur la touche [Sélection].

La liste des fi chiers TTS apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner un fi chier TTS 
téléchargé, puis tapez sur la touche [Sélection].

Vous pouvez écouter le fi chier.

Il est possible de régler la vitesse et l’intervalle de saut en tapant sur [ ].

Reportez-vous à <EmoDio> EmoDio pour plus de détails sur la fonction TTS.REMARQUE



écoute de la radio FM _ 71

écoute de la radio FM
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

ÉCOUTE DE LA RADIO FM
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 

sélectionner <FM Radio> (Radio FM), puis tapez sur la 
touche [Sélection].

La réception de la radio FM est activée.

POUR UTILISER LA FONCTION MUTE (MUET)
1. Tapez sur la touche [Sélection] en écoutant la radio FM.

Le son est désactivé.

2. Tapez à nouveau sur la touche [Sélection] pour reprendre l’écoute.

Branchez toujours vos écouteurs sur le lecteur lorsque vous recherchez ou réglez 
des fréquences.
Les écouteurs sont utilisés comme antennes de réception des ondes FM.
Il se peut que le lecteur ne trouve pas de fréquences FM disponibles dans les régions 
où la réception est mauvaise.

REMARQUE

REMARQUE
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RECHERCHE DE STATIONS FM
1. Appuyez longuement sur la touche [Gauche, Droite] et 

relâchez en mode Manuel.
La recherche s’arrête sur la fréquence la plus près du point où la 
touche est relâchée.

OU,

1. Tapez sur la touche [Gauche, Droite] pour rechercher les 
fréquences une par une en mode Manuel.

Change de fréquence à chaque nouvelle pression du touche.

Auto Searching
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POUR UTILISER LE MENU RADIO FM
To switch to Preset Mode
Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos 
présélections FM une à la fois.
1. Tapez sur [ ] en mode Manuel.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Go to Preset Mode> (Aller au mode pré-progr), 
puis tapez sur la touche [Sélection].

<Preset> apparaît.

Si aucune fréquence de présélection n’est défi nie, le 
lecteur ne passe pas en mode Présélection.

Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche 
manuelle d’une fréquence à la fois sur la bande FM.
1. Tapez sur [ ] en Mode Présélection.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Go to Manual Mode> (Aller au mode manuel), 
puis tapez sur la touche [Sélection].

<Manual> (Manuel) s’affi che.

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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POUR UTILISER LE MENU RADIO FM (Suite)
Programmation de stations sur la mémoire
Vous pouvez stocker jusqu’à 30 stations sur la mémoire du lecteur 
MP3 et y retourner simplement en appuyant sur un numéro. Laissez 
le lecteur MP3 choisir uniquement les stations que vous voulez 
en mode manuel ou trouvez et stockez toutes les stations locales 
automatiquement.
Manuel – choisissez uniquement les stations que vous voulez 
stocker
1. Tapez sur la touche [Gauche, Droite] pour 

sélectionner une fréquence à prérégler en mode 
manuel, puis sur [ ].

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Add to Preset> (Ajouter aux présél), puis tapez sur 
la touche [Sélection].

La fréquence sélectionnée s’ajoute sur la Liste 
présélection.

3. Pour défi nir d’autres fréquences présélectionnées, suivez les étapes 1 à 
2 ci-dessus.

Si la même fréquence est déjà défi nie, le réglage est désactivé.

Go to Preset Mode
Add to Preset
Auto Preset
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FM Sensitivity
FM Region
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POUR UTILISER LE MENU RADIO FM (Suite)
Programmation de stations sur la mémoire (Suite)
Automatique – pour enregistrer automatiquement toutes les 
stations reçues par le lecteur
1. Tapez sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<Auto Preset> (Présélection auto.), puis tapez sur la 
touche [Sélection].

La fenêtre de confi rmation apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner <Yes> (Oui), puis tapez sur la touche [Sélection].

Vous pouvez programmer automatiquement jusqu’à 30 sélections.

Annulation de la programmation automatique
Si vous souhaitez annuler la présélection automatique, tapez sur la 
touche [Sélection] durant le processus.

La programmation automatique est annulée et seules les fréquences 
programmées à ce point sont enregistrées.

Si vous souhaitez écouter votre lecteur MP3 dans une autre ville, il sera 
probablement nécessaire de reprogrammer vos stations. 
Répétez simplement le processus pour supprimer les stations 
programmées et en programmer de nouvelles.

Go to Preset Mode
Add to Preset
Auto Preset
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POUR UTILISER LE MENU RADIO FM (Suite)

Écoute des stations programmées
En mode Présélection, Tapez sur la touche [Gauche, 
Droite] pour faire défi ler les chaînes présélectionnées.

Vous pouvez alors écouter la fréquence radio attribuée 
à ce numéro.

Suppression d’une station programmée
Suivez les étapes suivantes pour supprimer les fréquences tout en 
écoutant la radio FM.
1. En mode Présélection, tapez sur la touche 

[Gauche, Droite] pour rechercher une fréquence 
présélectionnée à supprimer, puis sur [ ].

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner<Delete from Preset> (Suppr. du 
prérégl.), puis tapez sur [Sélection].

La fréquence sélectionnée est supprimée.

3. Pour supprimer des fréquences présélectionnées, suivez les étapes 
1 et 2 ci-dessus.

Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
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POUR UTILISER LE MENU RADIO FM (Suite)
Pour enregistrer une émission de Radio FM 
Vous pouvez enregistrer une émission de radio FM en tout temps pendant 
l’écoute de la radio. 
1. Tapez sur la touche [Gauche, Droite] pour 

sélectionner une fréquence à enregistrer en mode 
Radio FM, puis sur [ ].

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour 
sélectionner<Start Recording>(Démarrer
l’enregistrement), puis tapez sur [Sélection].

Un nom de fi chier créé automatiquement s’affi che et 
l’enregistrement commence.

Arrêter un enregistrement
1. Tapez sur la touche [Sélection] en cours 

d’enregistrement.
Un message s’affi che vous demandant si vous voulez 
écouter la lecture du fi chier récemment enregistré.

2. Tapez sur la touche [Gauche, Droite] pour 
sélectionner <Yes> (Oui) ou <No> (Non), puis 
tapez sur la touche [Sélection].

<Yes> (Oui) – le fi chier enregistré est lu.
<No> (Non) – le fi chier enregistré n’est pas lu.

Le fi chier enregistré est stocké dans <File Browser> (Dossier Navigateur) 
<Recorded Files> (Fichiers Enregistrés).
Un fi chier d’enregistrement radio FM peut durer jusqu’à 5 heures.
Vous pouvez stocker un maximum de 999 fi chiers d’enregistrement radio FM.
Vous pouvez enregistrer pendant environ 15 heures. (fondé sur 128 ko/s, 1 Go)
Le nom de fi chier d’enregistrement est alloué automatiquement : FM_
YYMMDD_XXX.MP3 par exemple. « FM » signifi e un enregistrement radio FM, 
« YYMMDD » indique la date d’enregistrement et « XXX » le numéro de fi chier.

FM Record

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

REMARQUE
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POUR UTILISER LE MENU RADIO FM (Suite)
Pour régler la Sensibilité FM
Permet la réception de plus ou moins de fréquences radio FM. Réglez la 
fonction <FM Sensitivity> (Sensibilité FM). 
1. Tapez sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<FM Sensitivity> (Sensibilité FM), puis tapez sur 
la touche [Sélection].

Le menu <FM Sensitivity> (Sensibilité FM) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
le niveau de recherche souhaité, puis tapez sur la touche 
[Sélection].

Sélectionnez entre <High> (Haut), <Middle> (Milieu) et <Low> (Bas).
Sélectionner <High> (Haut) augmente le nombre de fréquences reçues.

Tapez sur [ ] pour quitter le menu.

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

REMARQUE



écoute de la radio FM _ 79

POUR UTILISER LE MENU RADIO FM (Suite)
Réglage de la Région Radio
Vous pouvez modifi er les réglages de région FM avant d’aller à l’étranger.
1. Tapez sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) apparaît.

2. Tapez sur la touche [Haut, Bas] pour sélectionner 
<FM Region> (Région FM), puis tapez sur la 
touche [Sélection].

Le menu <FM Region> (Région Radio) apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner 
votre région FM, puis tapez sur la touche 
[Sélection].

Sélectionnez entre <Korea/US> (Corée/USA), <Japan> (Japon) ou <Other 
Countries> (Autres Pays).

Si vous modifi ez la fonction <FM Region> (Région Radio) de votre lecteur, 
les fréquences radio préprogrammées sont supprimées.
La région FM peut être supprimée ou modifi ée en fonction de la région 
cible du lecteur.
Bande de fréquences par région
- Korea/US (Corée/États-Unis) : Recherchez des fréquences FM comprises 
  entre 87,5 MHz et 108,0 MHz pour les lecteurs de 100 kHz.
- Japan (Japon) : Recherchez des fréquences FM comprises entre 76,0 MHz 
  et 108 MHz pour les lecteurs de 100 kHz.
- Other Countries (Autres Pays) : Recherchez des fréquences FM 

comprises entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

REMARQUE
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Datacasts 1/4

Datacast 1
Datacast 2
Datacast 3
Datacast 4

visualisation des diffusions de données
VISUALISATION DES DIFFUSIONS DE DONNÉES
Vous pouvez visualisez les articles de forum des chaînes ajoutées à <Datacasts> (Dif. donn.).

Avant de démarrer – Transférez l’élément de chaîne souhaité vers le lecteur avec 
<EmoDio>.
Qu’est-ce que la diffusion de données ?
Vous pouvez recevoir automatiquement des informations mises-à- jour sans avoir à 
accéder à des sites de nouvelles, de blogue ou UCC fréquemment visités à chaque 
fois.
Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

1. Appuyez longuement sur [ ] pour vous déplacer sur 
l’écran du menu principal.

2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 
sélectionner <Datacasts> (Dif. donn.), puis tapez sur la 
touche [Sélection].

La liste des diffusions de données apparaît.

3. Tapez sur la touche [Haut, Bas] pour sélectionner la liste 
de chaînes souhaitée, puis tapez sur la touche [Sélection].

La liste des fi chiers apparaît.

L’icône  : Texte principal de l’article transféré
L’icône : Fichier photo

L’icône : Fichier musical
L’icône : Fichier vidéo

4. Tapez sur la touche [Haut, Bas] pour sélectionner le fi chier 
souhaité, puis tapez sur la touche [Sélection].

La lecture du fi chier débute.
Reportez-vous à la rubrique <Datacasts> (Dif. donn.) de 
EmoDio pour obtenir des instructions détaillées.

REMARQUE

REMARQUE
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pour profi ter de l’offre prime pack
L’offre groupée Prime Pack vous permet d’utiliser différentes fonctions : 
lecture de texte, jeux, enregistrement vocal, etc.

Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

ENREGISTREMENT VOCAL
Vous permet d’effectuer un enregistrement vocal.

Pour faire un enregistrement vocal
1. Appuyez longuement sur [ ] pour vous déplacer sur l’écran du 

menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite]

pour sélectionner <Prime Pack> (Pack plus), puis 
tapez sur la touche [Sélection].

La liste <Prime Pack> (Pack plus) apparaît.

3. Tapez sur la touche [Gauche, Droite] pour 
sélectionner <Voice REC> (ENR. vocal), puis tapez 
sur la touche [Sélection].

4. Tapez sur la touche [Sélection].
L’enregistrement débute.

Le fi chier enregistré est stocké dans <File Browser> (Dossier Navigateur) 
<Recorded Files> (Fichiers Enregistrés).

Un fi chier d’enregistrement vocal peut durer jusqu’à 5 heures.
Vous pouvez stocker un maximum de 999 fi chiers d’enregistrement vocaux.
Vous pouvez enregistrer pendant environ 15 heures. (fondé sur 128 ko/s, 1 Go)
Le nom de fi chier d’enregistrement est alloué automatiquement : VCE_
YYMMDD_XXX.MP3 par exemple. «VCE » signifi e un enregistrement 
vocal, « YYMMDD » indique la date d’enregistrement et « XXX » le numéro 
de fi chier.

REMARQUE
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ENREGISTREMENT VOCAL (Suite)

Interrompre un enregistrement vocal
1. Tapez sur la touche [Sélection] en cours 

d’enregistrement.
Un message s’affi che vous demandant si vous voulez 
écouter la lecture du fi chier récemment enregistré.

2. Tapez sur la touche [Gauche, Droite] pour 
sélectionner <Yes> (Oui) ou <No> (Non), puis 
tapez sur la touche [Sélection].

<Yes> (Oui) – le fi chier enregistré est lu.
<No> (Non) – le fi chier enregistré n’est pas lu.

Ne tenez pas le microphone trop près ou trop loin de votre bouche ; cela 
peut affecter l’enregistrement.
L’enregistrement vocal n’est pas optimal lorsque le bloc-piles est trop 
faible.

Voice Record

ATTENTION



pour profi ter de l’offre prime pack_ 83

JEUX VIDÉO
Votre lecteur mp3 inclut déjà des jeux palpitants! 

Tapez sur [ ] pour vous déplacer vers l’écran précédent.
Appuyez longuement sur [ ] pour vous déplacer sur l’écran du menu principal.

1. Appuyez longuement sur [ ] pour vous déplacer sur 
l’écran du menu principal.

2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 
sélectionner <Prime Pack> (Pack plus), puis tapez sur la 
touche [Sélection].

La liste <Prime Pack> (Pack plus) apparaît.

3. Tapez sur la touche [Gauche, Droite] pour sélectionner 
<Games> (Jeux), puis tapez sur la touche [Sélection].

La liste <Games> (Jeux) s’affi che.

4. Tapez sur la touche [Haut, Bas] pour sélectionner le jeu souhaité, puis tapez 
sur [Sélection].

BOMB BOMB
Ce jeux fait appel à votre cerveau et vous devez modifi er l’ordre de 
trois blocs pour faire concorder les couleurs de 
l’image d’un marteau avec celles des blocs de la pile 
en retirant des blocs. Retirez autant de blocs que 
possible.
Tapez sur la touche [Gauche, Droite] pour déplacer 
les blocs sur la gauche ou sur la droite.
Tapez sur la touche [Up] pour changer la positions 
des blocs à l’horizontale ou à la verticale.
Tapez sur la touche [Down] pour faire tomber le bloc.

REMARQUE
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JEUX VIDÉO (Suite)
Bubble Smile
Vous tentez d’obtenir un maximum de points en changeant l’ordre de 
trois bulles à l’horizontale ou à la diagonale.

Tapez sur la touche [Haut, Bas, Gauche, Droite]
pour déplacer la combinaison de trois bulles.
Tapez sur [ ] pour déplacer l’ordre des bulles en 
sens horaire.
Tapez sur [ ] pour déplacer l’ordre des bulles en 
sens antihoraire.
Vous obtenez des points uniquement si vous 
réussissez à joindre trois bulles ensemble.

Chicken Runaway
Ce jeux vous laisse déplacer la poule et les poussins en les chassant 
sur la droite ou sur la gauche ; vous devez évitez les boules tombant du 
ciel pour protéger votre poule aussi longtemps que 
possible.

Tapez sur la touche [Gauche, Droite] pour déplacer 
la poule sur la gauche ou sur la droite.

Les jeux peuvent être ajoutés ou remplacés sans avis.
Reportez-vous à la section Help (Aide) pour plus de détails sur la manipulation. REMARQUE
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VISIONNEMENT DE LA CARTE MÉTRO MONDIALE
Permet de naviguer sur la carte métro mondiale et dans des endroits notoires 
aux environs des stations.
1. Appuyez longuement sur [ ] pour vous déplacer sur 

l’écran du menu principal.
2. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 

sélectionner <Prime Pack> (Pack plus), puis tapez sur la 
touche [Sélection].

La liste <Prime Pack> (Pack plus) apparaît.

3. Tapez sur la touche [Gauche, Droite] pour sélectionner 
<Subway> (Métro), puis tapez sur la touche [Sélection].

L’écran de sélection World Region (Régions du monde) s’affi che.

4. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour sélectionner la région 
souhaitée, puis tapez sur la touche [Sélection].

Sélectionnez une région parmi les valeurs suivantes : <AMERICA> (Amérique), 
<EUROPE> (Europe), <ASIA/OCEANIA> (Asie/Océanie).
Les villes de la région sélectionnée s’affi chent.

5. Tapez sur la touche [Gauche, Droite] pour sélectionner la ville souhaitée, 
puis tapez sur la touche [Sélection].

Le plan de métro de la ville sélectionnée apparaît.

6. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour sélectionner la région 
que vous souhaitez agrandir, puis tapez sur la touche [Sélection].

Si la carte agrandie contient des renseignements sur les attractions touristiques 
situées près de la station de métro, tapez à nouveau sur la touche [Sélection] 
pour affi cher la fl èche rouge. Tapez sur la touche [Haut, Bas, Gauche, Droite] pour 
sélectionner l’icône souhaitée, puis tapez sur la touche [Sélection]. Vous permet de 
localiser l’attraction touristique.

Tapez sur [ ] pour retourner à l’écran de sélection de la région mondiale.
Ceci peut être légèrement différent du véritable plan de métro.REMARQUE
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dépannage
Si vous rencontrez un problème avec votre lecteur MP3, trouvez une 
solution sur cette liste. Si le problème persiste, contactez le centre de 
service à la clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume 
pas.

• L’appareil ne s’allume pas si la pile est complètement 
à plat. Rechargez la pile et remettez l’appareil sous 
tension.

• Appuyez sur la touche Reset (Réinitialisation).

Les touches ne 
fonctionnent pas.

• Confi rmez que le commutateur [ ] est 
poussé vers le haut du lecteur.

• Confi rmez que vous avez appuyé sur la bonne 
touche, puis essayez à nouveau.

• Appuyez sur la touche Reset (Réinitialisation).

L’écran ne s’allume 
pas.

• Il se peut que les données affi chées à l’écran ne 
soient pas visibles sous les rayons directs du soleil.

• Si vous sélectionnez <Display Off> (Écran désactivé) 
du menu <Settings> (Paramètres) <Display>
(Affi cher), l’écran demeure éteint. Tapez sur une 
touche pour voir s’il s’allume.
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PROBLÈME SOLUTION

L’alimentation est 
coupée.

• L’alimentation se coupe automatiquement lorsque la 
pile est complètement à plat. Rechargez la pile.

• Si vous sélectionnez <Auto Power Off> (Extinction 
auto) dans <Settings> (Paramètres) <System>
(Système), le lecteur s’éteint lorsqu’il est en mode 
Pause. Allumez le lecteur.

La durée de vie de 
la batterie diffère de 
celle indiquée dans le 
manuel.

• La durée de la pile peut varier en fonction du mode 
sonore et des réglages de l’écran.

• La durée de la pile peut être réduite si vous exposez 
l’appareil à des températures basses ou élevées 
pendant des périodes prolongées.

Dysfonctionnement du 
programme EmoDio

• Confi rmez que votre ordinateur possède les 
caractéristiques fondamentales.

La connexion à 
l’ordinateur est 
désactivée.

• Vérifi ez si la fi che USB est bien branchée et 
réessayez.

• Exécutez la mise à jour de Windows sur votre 
ordinateur. Sélectionnez les mises à jour principales 
et les ensembles de modifi cations provisoires 
(Service Packs), puis mettez tout à jour. Redémarrez 
votre ordinateur et rebranchez l’appareil.

Le transfert de 
fi chier s’effectue trop 
lentement.

• Si plusieurs programmes sont ouverts sur votre 
ordinateur (dont <EmoDio>), la vitesse de transfert du 
fi chier sera ralentie. Quittez les programmes inutiles 
et essayez à nouveau.
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PROBLÈME SOLUTION

Le lecteur n’effectue 
pas la lecture.

• Vérifi ez que le fi chier disponible a bien été enregistré 
dans la mémoire.

• Assurez-vous que le fi chier musical n’est pas endommagé.
• Vérifi ez que la puissance de la batterie est suffi sante.

Le téléchargement de 
fi chiers ne fonctionne 
pas.

• Assurez-vous que le câble USB est bien branché.
Rebranchez si nécessaire.

• Assurez-vous qu’il reste de l’espace disponible sur la 
mémoire.

• Appuyez sur la touche Reset (Réinitialisation).

Des fi chiers ou des 
données manquent.

• Vérifi ez si le câble USB a été débranché durant 
le transfert du fi chier ou des données. Si tel est le 
cas, les fi chiers/données mais également l’appareil 
risquent d’être endommagés. Vous devez faire preuve 
d’une extrême prudence à cet égard car Samsung 
ne saurait en aucun cas être tenu responsable de la 
perte des données.

Affi chage anormal de la 
durée de lecture.

• Confi rmez que le fi chier est au format VBR (débit 
binaire variable).

L’appareil est chaud.
• Les phases de chargement peuvent générer de la 

chaleur. Cela n’a aucune incidence sur la durée de 
vie de l’appareil ou sur son fonctionnement.

Un message apparaît 
pendant que vous 
visionnez une vidéo.

• Essayez à nouveau de télécharger le clip vidéo via la 
fonction EmoDio.
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annexe
ARBRE INVERSÉ DU MENU
Voici un coup d’oeil rapide sur la répartition des menus et des fonctions de votre 
nouveau lecteur MP3.

Écran de sélection du menu

Music Videos Pictures Texts  FM Radio Datacasts Prime Pack File Browser Settings

Voice REC Menu Style

Games Sound

Subway Display

Language

Date&Time

System

Sound
Effect

Add
Bookmark Music On Music On

Go to Preset 
Mode /

Go to Manual 
Mode

DNSe Go to 
Bookmark

FM Radio 
On FM Radio On

Add to Preset /
Delete from 

Preset

Play Mode Delete
Bookmark

Start
Slideshow

Go to 1st 
Page Auto Preset

Music Play 
Screen Brightness Zoom Add

Bookmark
Start

Recording

Play
Speed DNSe Rotate Go to 

Bookmark FM Sensitivity

Skip
Interval Auto Pivot Delete

Bookmark FM Region

Repeat
A-B Mode 

On
Transition 

Effect
Text Viewer 

Color

Select as 
My Skin Font Size

View Type

Language
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CARACTÉRISTIQUES DU PRODUIT
Nom du modèle YP-Q1
Caractéristiques nominales DC 5,0V/ 500mA
Built-in Battery Power 620 mA/h / 3,7 V CC
Fichier Compatibilité AUDIO : MPEG1/2/2.5, 3 couches (8 ko/s à 320 

ko/s, 22 kHz à 48 kHz), WMA (8 ko/s à 
320 ko/s, 8 kHz à 48 kHz)

VIDÉO : SVI (Vidéo : MPEG4, Audio : MP3 (44,1 
kHz, 128 ko/s)), WMV (Vidéo : WMV9 
profi l simple, Audio : WMA Spéc. (Max 
860 ko/s), Résolution : 320x240, Vitesse 
de défi lement : 9 mètres/s (30 pi/s)

IMAGE : JPEG (ISO/IEC 10918-1/Annexe F – Mode 
de fonctionnement séquentiel DCT)

Nombre de fi chiers pouvant 
être accueillis

Dossiers : 1000 max / Fichiers : 6000 max 
(dossier compris)

Sortie des écouteurs 20 mW/canal. (sur 16 )
Bande de fréquences de la sortie 40Hz~20kHz
Rapport signal sur bruit 90 dB

Durée de lecture

Musique : Max. 30 heures (MP3 128 ko/s, Volume : 
15, mode normal, écran ACL éteint)

Vidéo :  Max. 4 heures (luminosité 5, Volume : 15, 
mode sonore normal)

Plage de températures de 
fonctionnement -5~35°C (23~95°F)

Étui Plastique
Poids 65 g
Dimensions (L x H x P) 51 x 98 x 10,9 mm
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Radio FM
Fréquence FM 87,5~108,0MHz T.H.D. FM 1%

Rapport signal FM 55 dB Sensibilité FM 
utile 38dB

• Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré 
sans notifi cation préalable.

• Cet appareil numérique de la classe B est conforme à la norme NMB-003 du 
Canada.
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LICENCE
L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence 
sous certains droits de propriété intellectuelle de parties tierces. Cette licence 
est limitée à une utilisation privée non commerciale par l’utilisateur fi nal pour les 
contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue 
à un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 
11172-3 ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou 
décoder des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des 
fonctions du produit qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou 
ISO/IEC 13818-3.



Garantie Limitée Samsung
Samsung Electronics Canada Inc. (SECA)
garantit ce produit contre tout défaut de fabrication.
SECA garantit aussi que si cet appareil ne fonctionne pas convenablement durant la 
période de garantie et qu’il s’agit d’un défaut de fabrication SECA se réservera le droit 
de réparer ou de remplacer l’appareil défectueux
Toutes les réparations sous garantie doivent être effectuées par un Centre de service 
autorisé SECA. Le nom et l’adresse du Centre de service le plus près de chez vous 
peut être obtenu en composant sans frais le 1-800-726-7864 ou en visitant notre site 
web au www.samsung.ca

 Main-d’oeuvre Pièces

 un (1) an (au comptoir) un (1) an

Pour tous les modèles portatifs, le transport de l’appareil sera la responsabilité du 
client. Le reçu de vente original doit être conservé par le client car cela constitue sa 
seule preuve d’achat acceptée. Il doit le présenter au Centre de service agréé au 
moment où il fait la demande d’une réparation sous garantie.
Exclusions
Cette garantie ne couvre pas les dommages causés par un accident, un incendie, une 
inondation, un cas de force majeure, un mauvais usage ou une tension incorrecte. La 
garantie ne couvre pas aussi une mauvaise installation, une mauvaise réparation, une 
réparation non autorisée et tout usage commercial ou dommages survenus durant le 
transport. Le fi ni extérieur et intérieur de même que les lampes ne sont pas couverts 
par cette garantie. Les ajustements par le client qui sont expliqués dans le guide 
de l’utilisateur ne sont pas couverts en vertu de cette garantie. Cette garantie sera 
automatiquement annulée pour tout appareil qui aurait un numéro de série manquant 
ou modifi é. Cette garantie est valable seulement sur les appareils achetés et utilisés 
au Canada.



Si vous avez des suggestions ou des questions concernant les produits 
Samsung,

veuillez contacter le Service Consommateurs Samsung.

Samsung Electronique Canada Inc., Service à la Clientèle
1-800-SAMSUNG (7267864)

www.samsung.com/ca
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